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Abstract

The objective of the Wireless Intelligent Simulator Environment (WISE) is to promote Computer Science curricula at the University of Texas at Arlington. WISE is a test bed for several research areas in mobile computing, artificial intelligence, multimedia, distributed systems, wearable devices and robotics. WISE is based on the wumpus world game, that provides plenty of opportunity for research in these areas. WISE is an excellent opportunity for developing a number of hands-on exercises and will provide students a unique collaborative environment to expand their horizons in these areas using this new approach to learning. 
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Chapter 1: INTRODUCTION

The Department of Computer Science and Engineering (CSE) at the University of Texas at Arlington (UTA) has recognized that there is an enormous potential of research in the areas of Mobile Computing, Wearable devices, Multimedia, Image Processing, Artificial Intelligence, Robotics and Distributed Computing. There are a growing number of students in the Department of CSE at UTA who want to contribute to research in these areas. The Department of CSE at UTA strives to provide excellent facilities to its students for the same. The Department of CSE at UTA believes in exploring new opportunities for research and application development in a mixture of these areas. New areas of research emerge because of the overlap of existing research areas. For example                                         

· Mobile Computing: The advancements in wireless technologies, processing power of hardware and high speed networks, led to the shift in paradigm of computing — users do not want to be constrained to one place where a computer is available, but instead want to be mobile. This opened up an exciting new research area  — Mobile Computing. 

· Multimedia on Internet: Advent of Multimedia revolutionized the Internet, which earlier used to be a medium of sharing dull text. Multimedia has enabled a multitude of customer-oriented business services providing information and source of entertainment over the Internet.

· Multimedia Communication in Mobile Environment: A growing number of mobile customers are accessing the Internet over a wireless medium. There is a demand for accessing multimedia services over the wireless medium. This offers tremendous challenges because of the problems associated with the limited bandwidth, frequent disconnections and limited computing power and short battery life of cellular devices.  This has opened several challenging research opportunities in multimedia communication in mobile environments. 

· Image Processing: With the advent of satellite imagery, technologies like Remote Sensing and Geographic Information Systems draw a lot from the research in Image Processing. Image Processing techniques are used to identify real world data from an image. Image Processing techniques use several algorithms that lie in the domain of Artificial Intelligence. An object can appear differently depending upon the angle at which it is viewed, the lighting or if it is partially obstructed by other object. Another problem involves deciding what features belong to which object. The computer needs tremendous processing power and intelligent algorithms to match the human ability to do the same.
 

· Artificial Intelligence: Research in Artificial Intelligence (AI) is used in data mining, robotics, machine learning, image processing, etc. AI draws from research in Data structures and algorithms. 
AI attempts to simulate aspects of human thought on computers. It includes research in [1]

· Natural language processing: The ability to communicate in English (or some other human language).

· Knowledge representation: The ability to store information provided before or during an interrogation.

· Automated reasoning: The ability to use the stored information to answer questions and draw conclusions.

· Machine learning: The ability to adapt to new circumstances and to detect and extrapolate patterns.

· Computer vision: The ability to perceive objects.

· Robotics: The ability to move them about and path planning. 

The Department of CSE at UTA has realized the need to change the course work in the areas of mobile computing, wearable devices, multimedia, robotics, and artificial intelligence and distributed systems. Hands-on experience is required to enhance students’ interest and expertise in these areas. Dr. Diane Cook, Dr. Larry Holder, Dr. Ramesh Yeraballi, Dr. Manfred Huber, Dr. Sajal Das, Dr. Farhad Kamangar are Principal Investigators (PIs) in these areas. 

 The PIs have proposed a unique collaborative environment, the WIRELESS INTELLIGENT SIMULATOR ENVIRONMENT (WISE), that will encompass several of these research areas and provide students with a rich learning experience. The National Science Foundation (NSF) has sponsored WISE.

WISE will be used to develop new classes and refining existing classes, giving Computer Science undergraduate students access to a large-scale distributed mobile agent laboratory containing both real and simulated agents. [1] 

WISE simulates an early computer game – the wumpus world (WW). In Chapter 2, we explain the game on which WISE is based. It is followed by an explanation of WISE version 1.0. 

Chapter 3 specifies the system requirements. Chapter 4 presents the USE CASE scenarios for WISE version 1.0. Chapter 5 shows the extended use cases. Chapter 6 explains the design of the class diagram. Chapter 7 provides the details of the implementation. In Chapter 8, we conclude with the present status of WISE version 1.0. Chapter 9 mentions the possible future extensions to the WISE version 1.0. Appendix A provides information about the Principal Investigators in WISE. Appendix B provides information about the Official Website of WISE and Appendix C provides the USER MANUAL with instructions to install, compile, and run WISE version 1.0.

Chapter 2. WIRELESS INTELLIGENT SIMULATOR ENVIRONMENT (WISE)

2.1 Overview:

WISE is designed to enhance Computer Science curricula at the University of Texas at Arlington in the fields of mobile computing, robotics, image processing, artificial intelligence, wearable computing devices, distributed algorithms and multimedia. WISE achieves this by simulating the WW—an early computer game used as an example domain in Russell and Norvig’s AI book. 

WISE extends the WW game by adding several other aspects that make it suitable for research in these areas. In section 2.2, the basic WW game and implementation details are described. In section 2.3, an overview of the Wireless Intelligent Simulator Environment (WISE) is given. This section specifies the extensions that WISE provides to the basic WW game in its version 1.0. Section 2.4 describes the architecture of WISE version 1.0.

2.2 The basic WW game:

      2.2.1 A brief explanation: 

The game is based on an agent who explores the WW seeking gold treasure. The WW is a cave consisting of rooms connected by passageways. The WW is a living place for the wumpus, a dangerous beast and guardian of gold in WW. The WW also contains bottomless pits and obstacles. Agents or gold seekers can enter the WW from any room in WW and can move to any adjacent room (except to a diagonal room). An agent has to be extremely cautious when entering a room, since there might be a wumpus or a bottomless pit, either of which will defeat the agent in its pursuit of gold. An agent cannot enter a room that is rendered inaccessible because of an obstacle. Fortunately, it is possible for agents to know whether there is a wumpus or a pit in the adjacent rooms, as wumpii permeate their stench and pits generate a gentle breeze to the surrounding rooms. The agents also know if any of the adjacent rooms contain an obstacle because they perceive a bump. There is gold in several rooms in the WW. An agent is defeated when it enters a room that is occupied by a wumpus or has a bottomless pit. The agent’s goal is to collect as much gold as possible and climb out of the WW with as minimal number of moves as possible. The agent can climb out of WW successfully only from the room in which it started the game.

The agent makes a move based on the percepts it obtains from the room it currently occupies and the rooms adjacent to it. 

The percepts indicate the presence of 

· Gold in the room in which the agent is present.

· A wumpus, obstacle or pit in one of the adjacent rooms. 

Apart from these percepts, there are extended percepts. These include

· A natural language hint about the WW.

· An image percept that displays the wumpus, pit or obstacle (if there is any) occupying the adjacent room agent is facing and gold (if there is any) in which the room the agent is present.

     The agent can be oriented along four directions: NORTH, EAST, SOUTH or WEST.

The agent can take the following actions:

· Move forward

This action moves the agent to the adjacent room it is facing.

· Turn left

This action turns the agent’s orientation counterclockwise by 90o. Refer to Table 1.

	Current Orientation
	New Orientation

	NORTH
	WEST

	WEST
	SOUTH

	SOUTH
	EAST

	EAST
	NORTH


Table 1: Turn Left

· Turn right

This action turns the agent’s orientation clockwise by 90o. Refer to Table 2.

	Current orientation
	New orientation

	North
	East

	east
	south

	south
	west

	west
	north



Table 2: Turn Right
· Sit 

This action keeps the agent in its present room and orientation.

· Shoot an arrow 

This action shoots an arrow in the direction along which the agent is oriented. The arrow travels along the direction it was fired and stops when it hits an obstacle or a wumpus. If it hits a wumpus, that wumpus is defeated.

· Grab gold

This action collects the gold in the present room.

· Climb out 

This action makes the agent climb out of the present room in WW.  This action is successful only if the agent is in the position from which it started the game.

A  trial, or single game, is over once the agent is either defeated, successfully climbs out of the WW, or exhausts a maximum number of moves. There can be several trials in a WISE session. The agent may adopt a new strategy based on experience obtained from previous trials.

There can be several wumpii in the WW. A wumpus may select its own actions based on a strategy specified as a parameter to the wumpus. Wumpii can be moving around in the WW randomly, moving to the closest room containing a pit or gold, spinning in the current room, walks until it hits an obstacle and turns left and starts walking again or sitting in the same position and orientation throughout the game.

	Modes of movement of WUMPUS

	STAY

	WALK

	RANDOM

	GOTO PIT

	GOTO RANDOM

	SPIN


Table 3 : Modes of Wumpus

 The 
agent can be either active or inactive. The agent is active while it still has the capability to make moves. But if it is defeated, it becomes inactive until the next trial starts, provided the game is not over. After every trial, the agent starts the next trial from the original starting room. 

There can be a required number of agents playing the game at the same time. These agents play the game independently.

Section 2.2.2 describes the implementation details of the basic WW game. This game will later be extended for WISE version 1.0.

2.2.2 Implementation details of the basic WW
 game:

The WW game has two components: The WW Server and the agent.

· WW Server (WWS)
: 

Here the basic functionality of WWS will be discussed. This will be extended in later 

sections for WISE version 1.0.

The basic WWS simulates the WW. The WW is assumed to be a 10 X 10 grid. Each grid location represents a room in the WW. These grid locations contain gold, wumpii, obstacles and pits. Refer to Figure 1.

The WWS waits for accepting requests for connection from agents at a specified port number. Once the required number of agents successfully obtains connections with the WWS, the agents enter the WW from room [0, 0
]. 

The WWS sends percepts to the agents in the order in which they obtained connections with the WWS. The percepts are given in terms of 5 symbols [stench, breeze, glitter, scream, bump]. A Stench implies the presence of wumpii in the adjacent rooms, a Breeze implies the presence of pits in the adjacent rooms, a Glitter implies that gold is located in the currently occupied room, a Scream implies that a wumpus was shot by an arrow in the last action, and a Bump implies that adjacent rooms may be inaccessible because of the presence of obstacles. 

The WWS receives actions [Move forward, Turn Left, Turn Right, Sit, Shoot An Arrow, Grab, Climb] to be taken from the agents in the order in which they obtained connections with WWS and simulates the execution of that action. 

A trial ends when all the agents have finished that trial. A game ends when the number of trials completed is equal to the number of trials specified for a game or all the agents are disconnected.

 The WWS maintains a score for each agent. The WWS maintains a score for every move the agent make. Collecting GOLD yields 1000 points, climbing out successfully yields 10000 points, and every move costs 1 point (a reward of –1).  

· Agent: The agent is a skillfully written software program that obtains a connection with the WWS using a specified IP address and port number. The agent receives percepts from the WWS, uses the percepts to determine the action to be taken, and sends the action choice to the WWS. The agent plays the game until the specified number of trials per game is not over or the agent gets disconnected from the server. 
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                   Figure 1. A typical WW. 

2.3. WISE version 1.0: Overview

WISE version 1.0 extends this game to have a physical WW on the 2nd Floor of Nedderman Hall, at the University of Texas at Arlington. The 2nd Floor of Nedderman Hall is modeled as a grid containing cells of size 2ft X 2ft. 

Agents can play this game remotely over the Internet. The agents have their representation in the WW in the form of an avatar. There are three forms of avatars. 

1. Human

2. Robot

3. Software

Human and Robot avatars are physical entities while Software avatar is a virtual entity. The Software avatar exists only in the WWS while the Human and Robot can move around the 2nd Floor of Nedderman Hall. So the agent (Human or Software) could be remotely controlling a Human, Robot or a Software entity in the WW. 

If 
the agent has a corresponding Human or Robot avatar, the agent can obtain live video images from its corresponding avatar either at a specified refresh rate (in the range of 1..300 seconds) or on—demand. 

If the avatar is a Software entity, then the agent gets an artificial image prepared by the WWS. This opens up a number of image processing research opportunities when the agent is a software program.

The agent sends the action to be taken to the WWS. The WWS makes sure that the selected action is a valid move. A move is valid when the new location is in the WW and does not contain obstacles. All the valid moves are forwarded by the WWS to the corresponding Human or Robot avatar (if there is one).

The communication between WWS, agents and avatars are based on sockets. These connections may fail for several reasons.

1. The WWS shuts down.

2. The agent closes the connection with the WWS or avatar.

3. The avatar runs out of power and gets disconnected.

WISE Version 1.0 discovers loss of connections by using timeouts.

Figure 2 in Section 2.4 illustrates the architecture of WISE version 1.0.

Section 2.4: Architecture of WISE version 1.0:




















Figure 2: WIRELESS INTELLIGENT SIMULATOR ENVIRONMENT

In this chapter, an overview of WISE version 1.0 was given. This was followed by a discussion on the architecture of WISE. In the following chapters, the software engineering process used to implement WISE version 1.0 will be discussed. In the next chapter, the requirement specification of WISE version is presented. 

CHAPTER 3: SYSTEM REQUIREMENTS

In this chapter, the requirements for WISE version 1.0 are presented. 

WISE version 1.0 consists of 

· Wumpus World Server (WWS)

· Agent application

· Avatar application

Requirements for WWS:

R1. WWS models 2nd Floor of Nedderman Hall using a 2ft x 2ft grid.

           Explanation: 

The WWS is based on the wumpus world game. WISE version 1.0 has extended 

this game to have a physical Wumpus World in the 2nd Floor of Nedderman Hall

at UTA. The wumpus world is made of rooms. This is simulated by a 2ft x 2ft

grid.

R2. WWS allows user to provide utilities to specify locations of gold, pit, obstacle, 

       wumpus in WW.

            Explanation: 

 The WWS consists of gold treasures, pits, obstacles, wumpii. The WWS should have utilities such that users can specify the locations of gold treasures, pits, obstacles, and wumpii in the WW.

R3. WWS allows the user to undo the action of placing an entity in WW.

            Explanation: 

The WWS allows user to specify the location of a WW entity in WW. It will be 

useful to have a option to undo the action.

R4. WWS allows the user to save the locations of WW entities to a file.

            Explanation: 

The user can specify the locations of WW entities in WW. All the effort will be

 lost once the WWS closes. To prevent this, the WWS allows the user to save the 

 locations of WW entities in a file.

R5. WWS allows user to load locations of WW entities from a file.
            Explanation: 

The WWS allows the user to save the locations of WW entities in a file. This 

option allows the user to load the locations of WW entities from a file rather than 

specifying every time the WWS is started.

R6. WWS supports the following modes of a wumpus. 

       [STAY,SPIN,RANDOM,WALK,GOTO GOLD, GOTO PIT]

            Explanation: 

Wumpus is an active entity in the WW. It can move around in the WW. It has 

several modes of operation. The default mode is STAY.

R7. WWS allows the user to specify, save to a file, or load from a file the wumpus’s 

       mode.

            Explanation: 

This should be provided along with R2 while the user is specifying the location

 for the wumpus. WWS allows the user to save and load this information along 

with the location information of the wumpus in R4 and R5.

R8. WWS allows user to specify configuration. The configuration includes the number of 

       trials per game, number of steps per trial, required number of agents, port number at 

       which the WWS should be accepting requests for connections, mode of serving the 

       agents ( round robin, asynchronous ) and time (in minutes) WWS should wait to accept 

       requests for connections from agents.

Explanation: 

WWS simulates an environment where an agent can learn about the environment 

in WW and can try and compare different strategies in various trials in a game. 

For an agent to start playing the game, it should obtain a connection with the 

WWS successfully. Thus the user should be able to specify the port number where 

the WWS should wait to accept   requests for connections. The WWS cannot wait indefinitely and hence the user can specify the maximum time (in minutes) the WWS can accept requests for connections from the agents. An agent cannot play a trial indefinitely. Thus user can specify a maximum number of steps an agent can execute in a trial. 

R9.  WWS allows user to register the IP address and port number of the robot or human 

        avatars (if any).
Explanation:

WWS is an extension to the original wumpus world game in that it models 2nd 

Floor of Nedderman Hall as WW where physical avatars of the agents can be 

moving. 

These physical avatars are either humans or robots. They represent the agent (which could be playing the game remotely) in the WW. These avatars provide the image percept of WW to their corresponding agents on—demand or at a regular refresh rate. 

To enable this, an agent should have a connection with the corresponding avatar. When an agent requests for connection with the WWS, it specifies the type of avatar desired. If the avatar requested is human or robot, the WWS checks for availability and if available, the WWS sends the IP address and port number of the avatar. The agent uses this information to obtain the connection with the avatar and can receive the image percepts.

R10. User can to start WWS for accepting requests for connections after 

         having set up the location of WW entities and configuration.

         
Explanation:


The user after having set up the initial location of WW entities and the 

configuration, can now start the WWS so that it can start waiting to receive 

requests for connections from the agents.

R11. WWS displays the current status of the game.
         
Explanation:

The user can see the current status of the game in terms of the number of agents who have obtained a connection with WWS successfully and when the game has started.

R12. WWS displays the location of WW entities and the agents along with their 

         orientation.

Explanation:

Once the agents start receiving the percepts, they send the actions to the WWS. The WWS executes the action and updates their position on the WWS display of 2nd Floor of Nedderman Hall. This will give the user an overall picture of where every agent is.

R14. WWS allows agent to close the connection with it.

       
 Explanation:

The agent can close the connection with the WWS while the game is in progress. The WWS determines that the connection is closed.

R15. User can terminate the WWS.
        
Explanation:

The user can terminate the WWS while the game is in progress. The agents who are playing the game should be able to detect this.

Avatar Application:

R16. The user can specify the port number.
            Explanation:

Avatar application is used to send the image percepts from robot or human avatar to the agent. The avatar application should be waiting at a port number where the agent can send a request for connection. The user can specify this port number.

R17. The user can stop the transmission of images to the agent.

       
Explanation:


The user can stop the avatar application from sending images to the avatar.

Agent Application:

R18.  WWS supports human and software agents. 


Explanation:

WISE  version 1.0 is designed to develop adaptive and self learning algorithms. To compare how well they play the game against a human, WWS supports two forms of agents (human and software agents).

R19. Agent application allows the user to specify the starting location in the wumpus 

          world.

        
Explanation:

The user can start specify the where in WW will the agent start playing the game. 


R20. Agent application allows user to obtain a connection with the WWS.
        
Explanation:

The user can specify the IP address and port number of the WWS and obtain the connection with the WWS. For the connection to be successful, the agent must choose a starting location in WW, choose the avatar (software, human, robot) and choose the agent (human or software)

R21. Agent application displays the percepts received from WWS.
         
Explanation:

When the connection has been established with the WWS, the WWS sends the percepts according to the location of the agent. The agent application receives the percepts and displays them. 

R22. Agent application allows agent to specify the action to be taken.
         
Explanation:

The agent application allows the agent to specify the action to be taken. It sends the action to the WWS.

R23. Agent application displays the points scored by an agent in each trial.
         
Explanation:

As the agent plays the game, the agent accumulates points. The agent application updates the display with the points accumulated by the agent after every move in a trial.

R24. Agent application displays the last action taken by the agent.
        
Explanation:

As the agent moves around in the WW, it is useful to know the previous actions so that the agent can use this information in calculation of next move.

R25. Agent application allows the agent to obtain an image of the cell it is facing on 

        demand or at a regular refresh rate.

Explanation:

Once the agent obtains connection to the avatar (human or robot), the agent can obtain images from the agent. The agent may choose to get these images on—demand or at a specified refresh rate.

R26. Agent application displays the current location of the agent and the location at 

         which the agent entered the WW.

Explanation:


The agent application displays the current location and the starting location of the 

agent in the WW; i.e., 2nd Floor of Nedderman Hall.

R27. The agent application displays the log of all actions taken by the agent.

Explanation:

As the agent moves in the WW by specifying actions, the agent application displays a log of the action taken, whether it was successful or not for all the trials.

R28. The agent application displays the current trial, maximum trial, current step and 

          maximum number of steps to be taken.

Explanation:

The agent application displays the current trial number, maximum trials per game, current step and maximum steps per trial. This information gives an the information regarding the trial number and current step in the trial.

In the next chapter, we discuss the USE CASES for WISE version 1.0. 

Chapter 4: USE CASE DIAGRAMS

Use case diagrams are a way of describing the external view of the system and its interactions with the outside world. In use case diagrams the external world is represented as actors. Actors are the users of the system. Use cases represent typical interactions that an actor has with the system. In this chapter, we present use case diagrams to illustrate how a user or an actor will use WISE version 1.0.

UC-1: SPECIFY  WW ENTITIES IN WW



This Use Case Begins With (TUCBW) the user clicking on the icon to place the WW entity.

The Use Case Ends With (TUCEW) the user clicking on the location where the WW entity should be placed.

	USER
	SYSTEM

	The user clicks on the icon of the WW entity to be placed.
	

	
	The mouse cursor changes to crosshair.

	The user clicks on the desired location in the WW.
	


UC-2:  SAVE  DETAILS OF WW ENTITIES


TUCBW the user choosing the “Save Wumpus World” sub-menu option from the File menu.
TUCEW the user saving the details of WW entities in a file.

	USER
	SYSTEM

	The user selects the “Save Wumpus World” option from the File Menu.
	

	
	The system prompts the save file dialog from which the user can choose the file.

	The user selects a file and saves the configuration in it.
	


UC-3: LOAD DETAILS OF WW ENTITIES


TUCBW the user choosing the “Load Wumpus World” sub-menu option from the File menu
TUCEW the user choosing the file from which the WW should be loaded 

	USER
	SYSTEM

	The user chooses the “Load Wumpus World” sub-menu option from the File menu.
	

	
	The system prompts a file selection dialog.

	The user chooses a file to load the WW entities.
	


UC-4: SET CONFIGURATION



TUCBW the user chooses the “Set Configuration” sub-menu from Simulator Menu
TUCEW the user applying the current configuration.

	USER
	SYSTEM

	The user chooses the “Set Configuration” sub-menu option from the File menu.
	

	
	The system prompts a Set Configuration dialog.

	The user specifies the desired values for the configuration and sets the configuration.
	


UC-5: REGISTER HUMAN AND ROBOT AVATARS


TUCBW the user loading one of the default configurations
TUCEW the user applying the current configuration.

	USER
	SYSTEM

	The user chooses the “Robot Details” sub-menu option from the Tools menu.
	

	
	The system prompts a “Robot Details” dialog.

	The user enters the details of the robot and sets the robot details.
	


The same procedure applies for “Human Avatars”

UC-6: START WWS



TUCBW the user loading one of the default configurations
TUCEW the user applying the current configuration.

	USER
	SYSTEM

	The user presses “Start” Button. 
	

	
	The system starts waiting at the specified port number for processing requests for connections.


UC-7: VIEW STATUS



TUCBW the user chooses the “Status” sub-menu in Simulator Menu.
TUCEW the user views the current status of the game.

	USER
	SYSTEM

	The user chooses the “Status” sub-menu option from the Simulator menu.
	

	
	The system prompts for the details of the game in a dialog.


UC-8: TERMINATE WWS



TUCBW the user chooses the “Exit” sub-menu in File Menu.
TUCEW the system stops execution.

	USER
	SYSTEM

	The user chooses the “Exit” sub-menu option from the File menu.
	

	
	The system stops execution.


UC-10: START AVATAR APPLICATION


TUCBW the user specifying the port number.
TUCEW the avatar application waits for connections from the agent.

	USER
	SYSTEM

	The user enters the port number 
	

	
	The agent application waits at the port number to accept connection from agent.


UC-11: STOP TRANSMISSION FROM AVATAR


TUCBW the user presses the stop button.
TUCEW the avatar application stops transmitting the images.

	USER
	SYSTEM

	The user presses the “Stop” button
	

	
	The agent application stops transmitting the images to the agent.


UC-12: SPECIFY STARTING LOCATION IN WW



TUCBW the user chooses “Display Layout”.
TUCEW the agent application marks the specified starting location.

	USER
	SYSTEM

	The user chooses “Display Layout” sub-menu in the Plan Menu. 
	

	
	The agent application displays the layout of 2nd Floor of Nedderman Hall.

	The user presses “Specify starting location” button on the layout dialog.
	

	
	The mouse cursor becomes crosshair.

	The user clicks the mouse at a desired location on the 2nd Floor of Nedderman Hall.
	

	
	The agent application marks the specified location.


US-13: SPECIFY DESIRED TYPE OF AVATAR



TUCBW the user selecting the desired the avatar.
TUCEW agent application updating the display.

	USER
	SYSTEM

	The user selects the desired avatar.
	

	
	The agent application updates its display.


UC-14: SPECIFY AGENT TYPE



TUCBW the user specifying the agent type.
TUCEW the agent application updates its display.

	USER
	SYSTEM

	The user selects the desired agent type.
	

	
	The agent application updates its display.


UC-15: OBTAIN CONNECTION WITH WWS



TUCBW the user specifying “Connect”button.
TUCEW obtaining connection with the WWS.

	USER
	SYSTEM

	The user presses the “Connect” button. 
	

	
	The agent application obtains connection with the WWS.


UC-16: SPECIFY ACTION TO BE TAKEN


TUCBW the user selecting the action to be taken
TUCEW the WWS executing the action.

	USER
	SYSTEM

	The user chooses selects the action to be taken .
	

	The user presses the “Action” button.
	

	
	The WWS executes the action.


The next step in the software engineering process is designing class diagram. This is discussed in the next chapter.

Chapter 5: CLASS DIAGRAM

The class diagram is a modeling technique that describes the types of objects in the system and various kinds of static relationships that exist between them. Three types of relationships are important:

· Associations (a student may borrow books from a library) 

· Subtypes (an hourly worker is an employee) and 

· Aggregation (wheels are part of a car). 

There are several modeling techniques that use different symbols for these relationships. UML is one of the popular modeling techniques that simplify these diagrams. In this section, we will use UML terms.  
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Chapter 6: CLASS DESCRIPTIONS

In this chapter we will discuss the functionalities of the classes in WISE version 1.0

Class : Action

Functionality:


This class provides all the actions that an agent can take.

Class GridObjectType

Functionality:


This class lists all types of objects in the WW. 

Class WorldObject

Functionality:


This class represents a generic object in the WW.

Class GridPoint

Functionality:


This class represents a grid location in the WW.

Class GridObject

Functionality:


This class represents a object to be placed in a grid location.

Class Direction

Functionality:


This class lists all the directions along which an agent can be oriented.

Class MovingObject

Functionality:


This class extends from GridObject. It provides the GridObject with an orientation.

Class ActorState

Functionality:


This class lists all the states in which an entity in the WW can be.

Class Actor

Functionality:


This class extends MovingObject. This represents a generic entity that has a location and orientation. It contains an instance of ActorState that provides the entity’s state.

Class Wumpus

Functionality:


This class represents a dangerous creature in the WW, the wumpus.  A wumpus contains instances of class GridPoint. These are used to represent the current wumpus location and the location toward which the wumpus is moving.

Class CustomizedPanel

Functionality:


This class displays the 2nd Floor of Nedderman Hall. It saves the positions of WW entities to a file. It loads positions of WW entities from a file. It updates the display with every move of agents and wumpii. 

Class Environment

Functionality:


This class has the entire information about the contents of every grid location in the WW. It launches a thread that updates the position of the wumpii. 

Class ConInfo

Functionality:


This object of this class is sent from the Server to the agent. This object contains the percepts, natural language hint, image percept (artificial), the robot or human avatar details. 

Class Percept

Functionality:


This class takes an object of class ConInfo and puts the percepts, natural language hints and image percepts in it.

Class RobotDetails

Functionality:


This class is a container for the IP address and port numbers of the RobotController and the laptop that provides the image percepts from the Robot avatar.

Class Monitor

Functionality:


This class is used by the Server to make the agents wait for other agents to finish the current trial in the asynchronous mode of handling messages.

Class ScoreBoardForAgents

Functionality:


This class represents the score of every agent playing the game.

Class MainContentPanel

Functionality:


This class contains the toolbar that is used to put the entities in the WW.

Class WWServer

Functionality:


This class is the Wumpus World Server. It accepts connections from the agents, sends them percepts, receives their actions and maintains the score. It is the class that coordinates all the activities in WWS. This includes displaying the 2nd Floor of Nedderman Hall, saving and loading positions of the WW entities, setting the configuration, displaying the status of the game, displaying the toolbar used to specify positions of WW entities, the registration of robot and human avatars, displaying the help, accepting connections from agents, sending them percepts, receiving actions, validating their actions and sending them to the associated avatars for execution, updating the display with current locations and orientation of the agents and other WW entities, maintaining the score for every agent during the game, and detecting loss of connections.

Please refer to Appendix C for the USER MANUAL on WISE version 1.0

We have now discussed the functionalities of the classes in WWS. This leads us to the conclusion of our discussion on WISE in the next chapter.

Chapter 7. CONCLUSIONS

WISE aims at enhancing students’ interest in mobile computing, distributed algorithms, artificial intelligence, multimedia, image processing and robotics. It achieves this by simulating the wumpus world game using a virtual model as well as the actual physical 
space of the second floor of Nedderman Hall. 

· In WISE version 1.0, we can have human, software, and robot avatars playing the game.

· WISE simulates the wumpus world game in a physical or a virtual world. This opens up a lot of research opportunities in the field of AI.  

· Agents can obtain images from their corresponding avatars. This could open the field of image processing to students to research. 

· The mobile avatars and agents bring into focus the wearable devices and other issues that come into play with mobile computing. 

· Robots are the avatars in the wumpus world that need to execute the instructions they receive from the agents and therefore also need to perform path planning. This opens up the exciting field of robotics and distributed algorithms for path planning for research. 

WISE version 1.0 is a complete package that encompasses all the research areas and fulfills its objective.  WISE version 1.0 thus meets its specifications and will prove to be an effective tool for extending the undergraduate curricula in Computer Science at the University of Texas at Arlington.

In the next chapter, possible extensions to WISE version 1.0 have been listed. 

CHAPTER 8. FUTURE WORK


WISE version 1.0 fulfills its requirements. In this chapter, we have identified several areas in which WISE version 1.0 can be extended. These are as follows.

1.  WISE version 1.0 currently uses the 2nd floor of Nedderman Hall as the wumpus

 world  environment. Future versions could be extended to include the entire      

 engineering campus. This could be possible after a wireless network has been installed  

 in the engineering campus. 

2. While working with physical avatars, one cannot be 100% sure about the current   

    coordinates of a robot or human, so there is a need for a tracking mechanism that will 

    report to the wumpus world server the actual physical coordinates of the robot or a 

    human avatar. This information will be used by the wumpus world server to determine 

    if the move was successful. The locator problem is a very interesting problem. It 

    is attracting a lot of attention of the Principle Investigators and students alike.

3. WISE version 1.0 will be used to extend course curricula of existing 

    undergraduate classes. Students could be provided with hands-on assignments to come   

    up with their own software agents that could play against a human agent. This opens a 

    whole new area of research. Hence another possible extension could be developing 

    some challenging and intellectually stimulating lab exercises using WISE version 1.0.

4. Currently the communication between the robot or human avatar and the wumpus 

    world server uses a datagram socket. This is not be very reliable and hence future 

    versions may change this to be connection oriented. This may introduce some challenges  because

    the code for robot is written in C++ while the wumpus world server uses jdk1.3.0. 

    This may require JNI to be used.

5. The wumpus plans its own path using the A* algorithm. Future versions of WISE may  

    include a host of algorithms from which the wumpus can choose.

6. In WISE version 1.0 the agents can only compete against each other. Future versions     

    may include collaborative agents where in a agents could play that game as team with 

    team strategies and group communication. This could open up some interesting 

    team combinations and multi-agent research issues (human agent interaction with another software agent and how 

    they can agree on a strategy, etc.).

7. A graphical utility that can provide comparisons pictorially how one agent out-

    performs another could be provided. 

8. WISE version 1.0 currently runs as an application. The agent interface can be put on 

    the web as an applet. This would enable the users to play from a distant location using 

    the Internet.

9. WISE version 1.0 provides agents with natural language hints that specify position of a 

    pit, obstacle, wumpus or gold in terms of coordinates [x,y]. This could be extended to 

    include hints like “you are next to Room 234 NH”. This will make the game more 

    interesting.

10. WISE version 1.0 needs manual automation to set up configuration of WWS, agent    

     application and avatar application. It may be extended to include an automatic  

     configuration from a file.
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APPENDIX B : OFFICIAL WEBSITE OF WISE

The URL address of the official website of WISE is: http://cygnus.uta.edu/wise/index.html.
This website provides the current status of the WISE project. 

It provides links to

· The Objective and Motivation behind WISE project.

· The Principal Investigators and contributers.

· The Official Demo of WISE.

· Source Code and Documentation of WISE Version 1.0.

· Publications.

Check the website for further versions of WISE.

APPENDIX C: USER MANUAL

This section of the report will cover:

C.1 Software Requirements for WISE version 1.0.

C.2 Instructions to install, compile and run: 

a. Wumpus World Server 

b. Agent 

c. Avatar

i. This is only for Robots or Human avatars. 

ii. The avatar application is required to send the images obtained from the camera to the agent connected to that avatar.

C.3 How to use WISE version 1.0.

C.4 Playing the game.

C.1. Software Requirements for WISE version 1.0:
a.    
Java version "1.3.0"

Java(TM) 2 Runtime Environment, Standard Edition (build 1.3.0-C)

Java HotSpot(TM) Client VM (build 1.3.0-C, mixed mode)

· Earlier version of JDK that support swing components can also be used.

· Using the following command to determine the version of java currently installed: java –version.

· If the required version of java is not found, obtain the correct version of J2SDK from http://java.sun.com/j2se/1.3/. It is available for 

Microsoft Windows, Linux x86 and Solaris SPARC/x86. 

b. Java Media Framework (TM) Version 2.1.1a (JMF)

· Obtain JMF from http://java.sun.com/products/java-media/jmf/.

· It is available for Microsoft Windows, Linux x86 and Solaris SPARC/x86.

   C.2.    Instructions to install, compile and run the application:

Platform: Microsoft Windows:

a. To install the server software:

i. Unzip the wise_server.1.0.zip into WISE directory using a Windows utility Winzip 8.0  (Download it from http://www.winzip.com).

ii. Change the current directory to WISE\WUMPUS.

iii. Compile the application using the command: 

javac WWServer.java
iv. Run the application using the command:

java WWServer

b. To install the agent software:

i.
Unzip the wise_agent1.0.zip into WISE_A directory.

i. Change the current directory to WISE_A\Client.

ii. Compile the application using the command: javac G_Client.java
iii. Run the application using the command : java G_Client
c. To compile the avatar software:

i. Unzip the wise_avatar1.0.zip into the HOME_A directory using a Windows Utility Winzip 8.0.

ii. Change the current directory to HOME_A\WISESNAPSERVER.

iii. Compile the avatar using the command: 

javac –classpath c:\jmf2.1.1a\lib\JMF.jar *.java.

iv. Run the application using the command:

java WiseSnapServer vfw://0


Platform: Linux x86: 

Follow similar instructions as specified for Microsoft Windows.                           

C.3. How To Use WISE version 1.0

WISE version 1.0 consists of the Wumpus World Server, the Avatar application and the Agent application. In order to understand the order in which these applications should be started and how they should be set up, the basic communication protocol of WISE version 1.0 should be understood.

The basic communication protocol for setting up the WISE version 1.0 is presented as follows: 

Configure the WWS. The IP address and port number of all robot and human avatars are registered at the WWS. WWS is launched to wait to accept requests for connections from agents. The agents obtain connection with the WWS using the IP address and port number of WWS. If the agent requests a human or robot avatar, the WWS should check the availability and send the IP address and port number of the allotted avatar. The agent then obtains the connection with the avatar to obtain the image percept. 

Hence, the order in which these applications should be started is as follows:

1.    Set up the Wumpus World Server (WWS). 

a. Set the configuration (The port number, number of trial per game etc).

b. Set the Wumpus World Entities.

c. Set up the information about the robot and human avatars.

d. Start the WWS so that it waits to accept requests for connections from agents.

2. For a Robot avatar:

a. Start the robot and place the laptop with camera on it.

b. On the laptop, run the Avatar application.

c.  Enter the port number where the laptop will be waiting for accepting request for connection from an agent.

3. For a Human Avatar:

a. Start the wearable device and initialize the camera.

b. Run the Avatar application.

c. Enter the port number where the laptop will be waiting for accepting request for connection from the agent.

4. Start the agent application:

a. Enter the IP address and port number of the WWS.

b. Select the agent type (Human or Software).

c. Select the desired avatar in the Wumpus World (Human, Software or Robot).

d. If the avatar is Human or Robot, choose whether the image percepts will be obtained on-demand or at a specified refresh rate.

e. Choose a starting location from where the agent will enter the wumpus world.

f. Obtain connection to the WWS.

All these steps are explained in detail in following sections. 

1. The WWS Application: Figure 1 shows the snapshot of WWS when launched. In the following discussion, the Coordinate System and Graphical User Interface (GUI) components of the WWS have been discussed. 
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Figure 1: Wumpus World Server for WISE version 1.0.

COORDINATE SYSTEM:

The coordinate system used in WISE version 1.0 is as follows.
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Figure 2. The coordinate system.

C.1.1. GRAPHICAL USER INTERFACE (GUI) COMPONENTS:  

The GUI components of WWS consist of: 

a. Layout of 2nd Floor of Nedderman hall

b. Status bar

c. Menu 

d. Toolbar

e. Start Button

f. Statistics Button

g. End Game Button 

Figure 3 identifies each GUI component.
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Tool Bar



The following sections describe the functionality of each GUI component. 

C.1.2.1 Status Bar

The 2nd Floor of Nedderman Hall is modeled using a 2ft x 2ft grid. The WWS displays this grid. The status bar gives the current location of the mouse over the wumpus world.

The mouse can be either at a location that is completely within the Wumpus World, a location that is not in Wumpus World, or at location that is partially within the Wumpus World. 

1. A Valid location:   A location that is completely within the WW
. For example, notice that the mouse is at a location [3,3] in Figure 4. This cell is completely within the WW. Hence the mouse is at a valid location.
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Figure 4: Displays the current position of the mouse. The mouse is located at [3,3].

2. Invalid Location:  A location that is partially within the WW.

There are some grid locations that are not completely within the WW. These grid locations cannot be occupied by human or robot avatars. Hence, these grid locations are labeled invalid as they are inaccessible. Notice that the mouse is at location [14,7] in Figure 5. This grid location is not a valid location as it is only partially within the WW.
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Figure 5: The mouse is over [14,7]. This cell is not completely within the 

Wumpus World.

3. Invalid Location: Location that is not in WW. 
Notice the position of the mouse in Figure 5. The mouse is placed at a location that is not within the WW. 


[image: image7.png]Wumpus World Server

le Simulator Tools Help

loving over imvalld location





      Figure 6: The mouse is over an area that is not a part of the Wumpus World.


   In the following section, the various menu options will be explained.

C.1.2.2. EXPLORING MENUS
The Menu options provided are as follows:

1. File

2. Simulator

3. Tools

4. Help

Functionality:

1.2.2.1 File Menu:

The File Menu provides the following options:

a. Load Wumpus World

Allows users to load the location of wumpii, gold pieces, pits, and obstacles from a file.


b.   Save Wumpus World

Allows users to save the location of  wumpii, gold pieces, pits, and obstacles to a file.

            c.    Exit

Shuts down WWS.

The following discussion explains these options.
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Figure 7: File menu option.

Load Wumpus World: 

This menu option allows the user to load the location of gold treasures, pits, obstacles, wumpii and their modes in the wumpus world from a file. This should be done prior to starting the WWS to wait for requests for connections from agents.
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Figure 8 : File “ashwin.txt” is being selected.

This file provides the location of the Wumpus World entities.

Contents of  file : “ashwin.txt”:

 [ 102,106 ]

Cell[6,3] : G 

Cell[6,3] : P 

Cell[7,3] : P 

Cell[9,3] : W STAY

Cell[9,3] : P 

Cell[4,4] : O 

Cell[6,5] : P


Format of file:

[102,106]: 

                              This line specifies the number of cells or grids along X and Y 

 

      directions. This should be the first line in the file.


Cell[6,3] : G 



     This line specifies that there is Gold in cell [6,3].


Similarly, P and O imply the presence of PIT and OBSTACLE, respectively.


Cell[9,3] : W STAY

This line specifies that there is a Wumpus in cell [9,3] and its mode is STAY. The other modes are specified by SPIN, GOTO_GOLD, GOTO_PIT, WALK, and RANDOM.
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Figure 9: Configuration loaded in Wumpus World from file “ashwin.txt”.

The presence of gold, obstacles, wumpii, and pits in a grid is displayed using squares filled with gray, blue, green, red color respectively. This is specified in the legend displayed in Figure 9.

 Save Configuration:


This menu option allows users to save the present location of wumpii, pits, and obstacles in a file.
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Figure 10: Current Configuration is being saved in “ashwin.txt”.

Exit: 


This menu option allows the user to close the WWS.

C.1.2.2.2 Simulator Menu:

The Simulator Menu provides the following options.

a.  Set Configuration

This sets the configuration of the WWS. 

b.  Status



This displays the current status of the game.


The following discussion explains these options.
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Figure 11: Simulator menu option. 

Set Configuration:

This menu allows the user to set the following information used by the server: 

a. The number of trials per game (=1, by default)

b. Number of steps per trial
(=1000, by default)

c. Maximum number of agents who can play the game (=10, by default)

d. Port number of the server (=5000, by default)

e. The message handling scheme

a. Round Robin

b. First Come – First Serve (This option is selected by default)

f. Time to accept connections (in minutes)

This sets the time for which the WWS will wait for connection requests from agents (=1 minute, by default)

When this time expires, the WWS stops accepting requests for connections from agents. It no agents obtained a connections or if the ones that obtained got disconnected, the WWS starts waits to be started again. The WWS is started by pressing the “Start” button. This is discussed in section 1.2.4. 
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Figure 12: Set configuration.

Figure 12 displays the current configuration setting.

Figure 13 shows how to set new values for number of trials, number of steps per trial, and time to accept connections. 

[image: image14.png]File Simulator Tools Help

start

w it
= umpus

10
5000
©) Round Robin Message Handling
® Fefs Message Handling
4 i
oK cancel

<

D]




Figure 13: Set number of Trials = 3, Number of steps per trial = 10, Time to accept connections = 2 minutes.

Status:

This menu option allows the user to view the status of the game.
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Figure 14: Displays the status of the game.

C.1.2.2.3 Tools Menu Option:

This menu option provides the following sub-menus:

a. Options

b. Robot Details

c. Show Toolbar
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Figure 15: Tools Menu Option.

Options Menu


This menu option is provided for future extensions of the WISE simulator.

Robot Details

This menu option allows the user to add the necessary information for a robot avatar to the WWS.


An agent controls a robot avatar in the Wumpus World by deciding which moves the robot should execute in the physical environment. The agent receives image percepts transmitted from a laptop mounted on top of the robot. The robot obtains the selected action from the agent and executes the action via a Robot Controller. To enable communication to and from the robot avatar, the IP address  and port number of the laptop and the Robot Controller must be provided for each robot available in the Wumpus World.
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Figure 16: The dialog used to provide information about a robot.

Figure 17 shows how to use this dialog to add information about the Robot Controller and about the laptop that sends the image percepts.
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Figure 17: The IP address and port number for both the Robot Controller and the laptop are provided.

The laptop has a camera that sends the image percepts to the agent. The information about the Robot Controller is used by the WWS to send actions to the robot. The Robot Controller forwards the action to be taken over the wireless medium to the robot.

The port numbers used are not constants. Port numbers greater than or equal to 1024 are usually preferred.

Show toolbar

This option allows the user to display or hide the toolbar.

[image: image19.png]Wumpus World Server
File_Simulator [Tools| Help





Figure 18: Shows the toolbar.

In Figure 19, the toolbar is not visible as the user chooses not to display it.
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Figure 19:  The toolbar is not visible.

C.1.2.2.4 Help Option:
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Figure 20: The Help Menu Option.
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Figure 21: The Help Dialog lists the Principal Investigators involved in WISE. 

C.1.2.3 TOOLBAR:

This section identifies the buttons on the toolbar and then describes their functionality. 

Buttons on toolbar from left to right represent 

a. Pit

b. Obstacle

c. Gold

d. Wumpus

e. Default Cursor

f. Undo

Figures 22 through 27 display the buttons for pit, obstacle, gold, wumpus, cursor, and undo, respectively.
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Figure 22: Notice the icon for placing a PIT in the Wumpus World.
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Figure 23: Notice the icon for placing an OBSTACLE in the Wumpus World.
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Figure 24: Notice the icon for placing a GOLD piece in the Wumpus World.
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Figure 25: Notice the icon for placing a WUMPUS in the Wumpus World.
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Figure 26: Notice the icon to set the cursor to the default ARROW POINTER.
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Figure 27: Notice the icon to UNDO the previous action of placing an entity in the WW.

The following section 1.2.3.1 describes the functionality of each of these buttons on the toolbar.

C.1.2.3.1 USING THE ICONS

To place an entity in the WISE simulator:

· Click the button on the toolbar representing the wumpus world entity (Pit, Obstacle, Wumpus, Gold) using the mouse. This changes the mouse cursor to crosshair. 

· Move the cursor to the desired location in the wumpus world. 

· Click to place the entity.

To place a pit:
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Figure 28: Pit is selected and is placed at cell [11, 2].

To place an obstacle:
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Figure 29: An Obstacle is placed at cell [12,3].

To place gold:
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Figure 30: A Gold Piece is placed at cell [11,4].

To place wumpus:
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Figure 31: A wumpus is being placed. Select the mode of the wumpus.
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Figure 32:The wumpus is placed at cell [15, 3]. Its mode is “stay”.

To set the cursor:
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Figure 33: The arrow button sets the cursor to be an arrow pointer.

To undo previous action:
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Figure 34: The UNDO button reverses the previous action of placing an entity in the wumpus world.

The next section describes the “Start button”.

C.1.2.4 START BUTTON
This allows the user to start WWS. Once started, the WWS waits to accept requests for connection from agents.
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Figure 35: Starting the WWS.
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Figure 36: The WWS is waiting for connections.

To check the status of the game, click the “Status” sub-menu in the Simulator menu.
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Figure 37: Displays the status of the WWS.

The server waits to accept connections for a number of minutes. This is set using the “Set Configuration Menu”. WWS displays the following message when

· No requests for connections from agents have been accepted. 

· All of the agents in the game got disconnected while the WWS was waiting to accept connections.
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Figure 38: No connections from any agents have been obtained. The server needs to be restarted.

C.2 AVATAR APPLICATION:

Configure the laptop that will transmit the image percepts from the robot or human avatar to the agent.

[image: image40.png](@
v

My Computer

W

My Network

5
[<.
Recycle Bin

Explorer

My Biifcase.

L

Orine
Services

Windaws
Media Player

T

o i

ImageStation

B

Audio Video
Applcatons.

55

Sony VAID
Regstation

i
e
VA Sugpon
o

=
)
Agent (2)

- A

Dowrload  POOD00GF.
Accelera,

e

WiZip  MSDOS
Frompt

Windaws

Explorer

@

My Docurents

Bef

IMstudo

o]

1P Address of Host 120.107.86.245

Port# start





Figure 39: Displays the application on the laptop that will transmit image percepts from the robot avatar to the agent. This requires a port number.
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Figure 40: Specify the port number and press the start button to transmit the image percepts.

To stop transmission, click on the stop button.
C.3 AGENT APPLICATION :  

This application is used to connect to the WWS and play the game. This section describes how to use this application to play the game. 
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Figure 41: Agent Application

An agent obtains a connection with the WWS at the specified IP address and port number. 

The agent can be one of the following:

· Human 

· Software client

The agent has its representation in the Wumpus World using an avatar.

In the Wumpus World, the associated avatar of an agent can be one of the following:

· Human
 

· Robot

· Software entity

The Human and Robot avatars are the physical representations of the agents in the Wumpus World. They execute the instructions provided by the agent and also provide an image percept at a regular rate or on-demand. The software avatar provides an artificially created image showing the contents of the adjacent grid the agent is facing.  Figure 42 identifies all the GUI components of the agent application.
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Figure 42: Agent Application.

C.1.3.1 Menu:

The following menus are provided:  

1. Plan

· Display Layout

· Exit

2. Percept

· Display Percepts
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Figure 43: Plan Menu in Agent Application.

Display Layout Menu:

· This displays the  2nd Floor of Nedderman Hall. 

· It allows the user to specify from where the agent will start the game.

· Once the game starts, it displays the current location and the starting location

in the Wumpus World.
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Figure 44: Layout of 2nd Floor of Nedderman Hall

C.1.3.2 Specify the starting location:

Instructions : Click on the button to specify the starting location. Then move the           


          mouse on to the desired location and click.  The system prompts 

          for the agent orientation (North, East South, West).
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Figure 45: Specifying the starting location in the Wumpus World

Notice that the  starting location specified is [15,3]. The application prompts for the starting orientation (North, East, South, West) of the agent.

C.1.3.3 Agent Display Percepts Menu:

This allows the user to view the 

· Percepts (breeze, stench, glitter, bump, scream), 

· Natural language hint, 

· Status information (last action, score, gold pieces collected, agent state, number of arrows remaining), 

· Maximum number of trials per game, maximum number of steps per trial, the current trial number and the current step number, and 

· Log generated by the system. This shows the current location and orientation, the previous action taken, status of the action (success or failure), and the previous trial score.

It also allows the agent to specify the action to be taken.  The choices are:

1. Forward

2. Turn Left

3. Turn Right

4. Stay

5. Grab

6. Climb

7. Shoot an arrow

C.1.3.4 Obtaining a connection with the WWS : 

Instructions to obtain a connection with the WWS:

1. Specify a starting location.

2. Provide the appropriate IP address and port number of the WWS.

3. Choose the appropriate agent (Human, Software).

4. Choose the appropriate avatar in the Wumpus World (Human, Robot, Software).

5. Click on the “Connect Button”.

The request for connection can fail for the following reasons:

1. The IP address or the port number or both provided for the WWS are incorrect.

2. The WWS has not started or has already stopped waiting to accept requests for connections from agents.

3. The agent starting location is not specified.

4. The starting location, though specified, is not acceptable as it is already occupied by another agent, a pit, wumpii, or an obstacle.

5. The requested avatar (Human, Robot) is not available to allot to the agent.
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Figure 46:  Connection request failed due to either reasons 1 or 2 stated above.
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Figure 47: The starting location is not specified.
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Figure 48: The starting location specified is already occupied by another agent, obstacle, pit, or wumpii.
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Figure 49: The requested avatar, in this case a “robot”, is not available.
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Figure 50: The request for connection has been accepted successfully.

Once the starting location is selected, it cannot be changed unless the request for connection is turned down. 

If the request for connection is not accepted, click the “Disconnect” Button.

Repeat the above procedure to obtain a connection successfully.

View Percepts and Send actions:
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Figure 51:  Agent Interface to play the game. 

An agent who requests a “Human” or “Robot” avatar obtains the IP address and port number of the corresponding avatar if the request is accepted successfully. Then the agent tries to establish connection with its avatar to obtain the image percepts. The following flowchart explains the process.
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Figure 52: The agent could not obtain the connection with its associated robot avatar to obtain image percepts.

There are two ways in which image percepts can be obtained from the “Human” or “Robot” avatar. These are as follows:

· On—demand

· Auto refresh at a specified rate
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Figure 53: Connection with avatar is established. Image percepts are obtained 

on demand.
When the agent has a software avatar, then the image percepts are synthesized using ppm images as shown.
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Figure 54: The image percept when software avatar is used. The grid location that the agent is facing contains a pit and a wumpus. 


[image: image56.png]"
My

ReaDow,
Documents
TN
= ap>

My ReaPlayer
Computer  Basic

L |
My save
Netwo.

Morton  mprepor.
Protecte.

|

Intermet  USER
Explorer  MANUAL

Microsoft
Outiook

Acrobat:
Reader 4.0

i
Norton
System

Plan Percept

Wumpus World Server IP

Port #

Avataar in wumpus world...

Dbtain Image..

Agentis ..

sooo |





Figure 55: The agent is facing an obstacle.

WWS, agents and avatars communicate with each other using sockets. There are several reasons why communication may halt.

· An agent can get disconnected.

· The WWS can shut down during the game.

The application should be able to detect these disconnections dynamically and inform the user. For this purpose, a time limit is set for every connection. A connection times out when no data packet is received within a specified time period.

The WWS accepts requests for connections for a specified number of minutes. Within this time period, it can accept a maximum of number of requests for connections from agents. 

The WWS handles the agents in two modes. These are as follows:

· Round Robin

· First Come—First Serve

Round Robin:

The server waits to accept requests for connections. It waits until it grants the maximum number of connections to agents or until it times out.

If no connections have been granted, then the WWS displays the appropriate message and waits to be restarted.

The agents are served by the WWS in the order in which they obtained their connection. 

The WWS sends the percept to the agent. The WWS waits for the agent to specify the action to be taken. The WWS waits for a  specified number of minutes. If it receives an action, it validates the action and sends the action to be taken to the associated avatar to execute it. It then sends the status of the action back to the agent. The WWS proceeds to then serve the next agent.

If the agent does not specify the action to be taken within the time limit, then the server assumes the action to be SIT and the agent does not move from the current location. But if this happens twice consecutively, the WWS assumes the agent to be disconnected and removes the agent from the game.


 




































































































































































































































































Asynchronous Handling Of Agents:

The WWS can process agent requests asynchronously. The agents obtain a connection with the WWS and start playing the game. The WWS sends the percepts to the agents and processes the actions received in an asynchronous manner. The agents can thus play their step independent of each other. In order to start a new trial, all the agents in should have finished the current trial. So if any agent finishes the current trial, then that agent goes to its starting location and waits for others to finish the current trial. When the current trial is done, a new trial is started.

There are several interesting cases here:

Case 1:























































































In the above case, the WWS is started at T0 and at T
1 Agent #0 obtains a connection. The Agent #0 starts playing the first trial. Once Agent #0 finishes the first trial, it waits to start the next trial. Notice that the WWS is still waiting for connections, so it waits until the WWS stops waiting for connections. So Agent #0 waits until T3 to start the next trial.












Case 2:


































































In the above case, once the first agent finishes the first trial at time T2, it begins to wait for the next trial. When WWS stops accepting connections, notice that Agent #1 is still playing the first trial. Hence the total number of agents playing the game is only two. Once Agent #1finishes the first trial, it notifies Agent #0 to start the next trial.

Case 3:














































































In the above case, Agent #0 obtains a connection with the WWS at T1 and disconnects at T2.  However, the WWS continues to accept requests for connection until T3.
The WWS is configured to allow a maximum number of agents to play the game. In the above case, let’s say 10 agents were allowed to play the game. Agent #0 obtained a connection. So WWS allows only 9 more agents to accept connection. But Agent #0 got disconnected while the WWS was still accepting connections from agents. Hence the WWS again allows 10 agents to play the game.

Detecting loss of connection:

The WWS and the agents have to detect loss of connection. If the WWS does not receive the action to be taken from the agent within a specified time period, it assumes the agent is disconnected and removes the agent from the game.

If all the agents get disconnected then the WWS displays a message that the game is over. The WWS should be started again by the user.

Actions that an Agent can take:

The agent can specify one of the following actions:

· GOFORWARD

· TURN LEFT

· TURN RIGHT

· STAY

· GRAB

· CLIMB

· SHOOT ARROW

GOFORWARD: 

This action makes the agent move forward in the direction it is currently facing. The point value associated with this action is –1.

This action may lead to the following possible outcomes:

Case 1:

The action fails as the agent tries to move into an invalid location in the Wumpus World. A location in the Wumpus World is invalid when

· It contains an obstacle or

· It is not completely within the Wumpus World.

Case 2:

The action fails as the agent associated with a “Robot” or a “Human” avatar attempts to move into a valid location that is already occupied by another agent associated with a “Robot” or “Human” avatar.  There is no restriction on the number of  “Software” avatars that reside in a given location.

Case 3: 

      The action causes the agent to be defeated as the agent moves into a valid terminating   location. A location is terminating when

· It contains a PIT or

· It contains a WUMPUS

Case 4: 

The action is successful as the agent moves into a valid location that is not terminating.

TURN LEFT:

This action makes the agent change its orientation without changing the current location. 

The point value associated with this action is –1.

The agent turns counterclockwise by 900.




TURN RIGHT:
This action makes the agent change its orientation without changing the current location. 

The point value associated with this action is –1.

The agent turns clockwise by 900.




STAY:

This action makes the agent stay at the same location. The point value associated with this action is –1.

GRAB:

This action allows the agent to pick up a gold piece available at the current location. This action may succeed or fail depending on whether any gold was at the current location or not.








The point value of this action is 1000 if it is successful, else it is –1.

SHOOT AN ARROW:

This action allows the agent to shoot an arrow in the direction it is currently facing. The arrow travels straight in the direction the agent is currently facing until it hits an obstacle or a wumpus. If it hits a wumpus, the wumpus is no longer in the Wumpus World. There can be several wumpii at the same location. In such case, only one will be shot.







CLIMB:

This action allows the agent to come out of the Wumpus World. This action is successful when the agent climbs out of the location where the agent started playing the game. If the agent attempts to climb out of a location that was not the starting location, this action fails. The point value with this action if successful is 10,000, else it is –1.

Cases for connection time outs:
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Figure 56: The WWS times out and no agent has obtained any connection

In this scenario, the game cannot start as no agents obtained connection with the WWS. Hence, the WWS displays a message and waits to be started again.

The WWS maintains a display of the current position and orientation of all the agents who are playing the game. It also displays which agents are waiting for other agents to finish their current trial. 
The position and orientation of an agent is displayed using a triangle.




























































































































If an agent is waiting for other agents to finish the current trial, it is displayed as

 



C.4. PLAYING THE GAME

Instructions to start WWS and avatars (human and robot).

· Set the configuration.

· Place Wumpus World entities (Obstacle, Wumpii, Pit, Gold) at desired locations.

· If there are any robot or human avatars available

· Add the Robot or Human details to the WWS

· Start the Robots. 

· Launch the application that would send the image percepts on the laptop

· Place the laptop on the robot with camera facing the same direction as the robot.

· Start the WWS by clicking on the “Start” button.

Instructions to start the Agent:

· Specify the IP address and Port number of the WWS.

· Set the starting location and orientation.

· Choose the type of avatar (Robot, Human or Software avatar).

· If the avatar is a “Robot” or “Human” then choose the way image percepts will be obtained (On—demand or automatic refresh at a specified interval).

· Choose the type of agent (Human, Software agent).

· Obtain the connection with WWS by clicking on the “Connect” button.

C.4.1 SAMPLE GAME

Place the wumpus world entities (gold, pit, obstacles, wumpus) in the wumpus world. Set the configuration of the WWS. Add Robot or Human avatar details if there are any. In this example, there are no robot or human avatars. 
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Figure 57: Set the configuration of the WWS. Number of trials = 2, Number of steps per trial = 15,Time to wait for accepting requests for connections  = 1 minute. 

After having set the configuration, the WWS is started by clicking on the “Start” button.

Now the agent should obtain connection to the WWS to start playing the game. For this the agent should choose the starting location from where the agent can enter the WW.

The agent is specifying the starting location in Figure 58.
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Figure 58: Set the starting location as [11,3], orientation facing NORTH. The avatar in Wumpus World is software entity and a “Human” agent is playing the game.

After having selected the starting location, the agent specifies the IP address and port number of the WWS and presses the “Connect” button to obtain the connection.
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Figure 59: The request for connection has been accepted by the WWS.

The WWS has accepted the agent’s request for connection. Only one agent has obtained the connection with the WWS so far.

The WWS updates its display and shows the current position and orientation of the agent who just obtained the connection.
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Figure 60: The WWS displays the current position and orientation of the agent playing the game.  The agent is located at [11,3], facing NORTH.

After the agent has obtained the connection, the agent looks at the percepts it receives from the agent. 
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Figure 61: Verify the percepts corresponding to the situation in Figure 60.

Specifying a move:

The agent specifies the move by selecting the action that needs to be taken and pressing the “Action” button. Here the agent specifies the action to be taken as TURN_LEFT.
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Figure 63: Action specified is TURN LEFT.

The WWS updates the display of the agent. The agent is now facing WEST.
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Figure 64: The WWS updates the location and orientation of the agent. The agent is facing WEST as a result of the previous action.

The agent can also see its current location in the layout of 2nd Floor of Nedderman Hall.
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Figure 65: The action being specified is GOFORWARD.
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Figure 66: The WWS updates the location of the agent as it moves forward. Notice that the agent has now moved forward.

The agent gets a new set of percepts as it moved forward. Notice the current location and the starting location of the agent.
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Figure 67: The agent receives a new percept.   The action sent to the WWS is 

Shoot Arrow.
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Figure 68: The agent shoots at a wumpus. The operation is successful. 
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Figure 69: The WWS updates the display by removing the wumpus that was shot.
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Figure 70: The agent turns left. The current position is [10,3] and the orientation is SOUTH.
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Figure 71: The agent sends an action to move forward.
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Figure 72: The WWS updates the position of the agent. The agent is now at [10,4] facing SOUTH.
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Figure 73: The agent sends an action to turn left.
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Figure 74: The WWS updates the orientation of the agent.  The agent is now facing EAST.
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Figure 75: The agent sends an action to move forward.
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Figure 76: The WWS updates the new location of the agent. The agent is now at [11,4] facing EAST.
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Figure 77: The agent is now grabbing the gold at [11,4].
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Figure 78:  The WWS removes the gold at [11,4] as it was collected by the agent.
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Figure 79: The agent sends an action to turn left.
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Figure 80: The WWS updates the orientation of the agent. The agent is now at [11,4] facing NORTH.
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Figure 81: The agent sends an action to move forward.
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Figure 82: The WWS updates the location of agent. The agent is at [11,3] facing NORTH.
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Figure 83: The agent climbs out of the Wumpus World.
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Figure 84: The first trial is over. To obtain the statistics, click on the “Statistics” button.

The first trial is over for the agent. For the second trial to start, the agent may have to wait under the following circumstances.

1. The WWS is not done accepting requests for connections from agents, or

2. Other agents are not done with the current trial.

In the above case, there is only one agent. The WWS is still accepting requests for connections from agents. Hence the agent waits.
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Figure 85: The agent is waiting at its starting location [11,3] facing NORTH.

Once the WWS gets done waiting, it notifies the agent to start the next trial.
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Figure 86: The agent is at the starting location [11,3] facing NORTH. It obtains percepts for the second trial.

A connection can time out on the agent’s side when no percept is received by the agent within a specified time limit. This occurs when one of the following conditions is true:

· The WWS generates a percept based on the action specified by the agent and then sends the new percept to the agent. If the agent does not send any action, then the WWS does not send any percept. As a result the connection at the agent’s side times out.

· The agent sends the action but the message is lost due to network problems. Since the WWS does not receive the message, the server does not send the new percept. Hence the connection times out.

· The WWS sends the percept but it is lost because of network problems. The agent does not receive the message and times out.

[image: image87.png]=lol x| [& _lo
Plan Percept
TO— O | ——
£ =] fizsaori2s |
PERCEPT INFORMATION 500
N ooz [ves
T ump [ves
soream: [N
NATURAL LANGUAGE HINT
Hint [ gier s behind you
% .

5
Lsc f1} Tho operation timed ou. Disconnecting from the server. Please reconnect
a5 B

= roa

GoldPieces: [0

Action To Be Taken

CForward C/Left O Right O Stay () ShootArow (O Grab @ Climb

15 B
1 B

Buccessiull B
(Current Location : 11, 3] Orientation : NORTH

tiempted to : CLIMB OUT OF WUMPUS WORLD.

‘ou have successfully climbed out Congratulations!!

‘ouwon the lastial Waitingto start a new trial

Trial #: 1, Your score = 10991

‘our start location s [11, 3] and Orientation is NORTH |





Figure 87: The operation timed out. The agent did not receive a new percept since it did not send an action within the time limit.

The WWS determines loss of connection with agents by using time outs. If it does not receive the action to be taken by the agent within a specified time limit, the connection with the agent times out. The agent is assumed to be disconnected and is removed from the game.
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Figure 88: The agent is disconnected. 

Agents get disconnected from the WWS dynamically. The WWS keeps track of all the agents currently playing the game. When there are no more agents playing the game, the WWS displays a message that the WWS should be restarted.
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Figure 89: The game is over as the only agent playing the game got disconnected.
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Figure 90: The WWS is waiting to be restarted for another game.

When the agent is disconnected from the WWS from either WWS’s side or the agent’s side, any attempt to send an action to the WWS results in an error.  
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Figure 91: The agent cannot send the action to the WWS when the connection with the WWS is disconnected.

This occurs when the WWS disconnects the agent as it did not receive the action to be taken with a specified time limit. After being disconnected, if the agent attempts to send an action, it receives this error message.
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The avatars are representations of agents in the WW. They execute the actions specified to them by an agent via WWS. The avatar has a camera. The avatar captures images using the camera and sends them to the agent on demand or at a regular refresh rate. So the agent at a remote location can see what the avatar is looking at!
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WumpusWorld Server: This grants a maximum number of connections to the agents.or times out. The connection is granted to an agent only if the agent gets the requested avatar [Human,Robot,Software]. 
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The agent (Human/Software) obtains a connection with the WWS. If the avatar requested is Human or Robot, the agent obtains the IP address and port number of the avatar. The agent gets a connection with the avatar to obtain image percepts. The agent continues to receive percepts from WWS and image percepts from the avatar. Agent sends the action to be taken to WWS. WWS validates and forwards the action to the avatar. If the avatar is Software entity, then the agent receives artificial image prepared by the WWS.
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Figure 3: Wumpus World Server Components.
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�PAGE \# "'Page: '#'�'"  �� Why do you have this particular date?  I would just have the month and year.  This particular date is probably not a good choice.


�PAGE \# "'Page: '#'�'"  �� Before you jump to a new subject (from multimedia to image processing), state the main point of the previous discussion – how does this apply to your project?


�PAGE \# "'Page: '#'�'"  �� New paragraph


�PAGE \# "'Page: '#'�'"  �� Sometimes you use Wumpus WorldWW, sometimes Wumpus worldWW, and sometimes wumpus worldWW.  Any of these capitalizations is fine, but use it consistently.


�PAGE \# "'Page: '#'�'"  �� Ok, now I am back to my earlier questions.  Are you describing the previous version of the game?  This 10x10 grid world is not used in WISE.  Be clear about what you are describing.


�PAGE \# "'Page: '#'�'"  �� Some of these points describe the original game, and some describe Kruti’s original implementation of a server.  I am not sure which you are trying to describe.  The game itself would not have a server – it is just an abstract game with rules.


�PAGE \# "'Page: '#'�'"  �� New paragraph


�PAGE \# "'Page: '#'�'"  �� Start with an introductory statement (all chapters need this).


�PAGE \# "'Page: '#'�'"  �� I suggest not numbering the items, but just making a paragraph out of each of your points.


�PAGE \# "'Page: '#'�'"  �� How do you define valid?  This is a location where an avatar can reside?
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